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Chapter 129

Equivalence Tests for
the Ratio of Two
Means (Normal Data)
Introduction
This procedure calculates power and sample size of statistical tests for equivalence tests from parallel-group design
with two groups when the data are assumed to follow the normal distribution (so the log transformation is not used).
This routine deals with the case in which the statistical hypotheses are expressed in terms of mean ratios rather than
mean differences.
The details of this analysis are given in Hauschke et al. (1999) and Kieser and Hauschke (1999).
Note that when the data follow a log-normal distribution rather than the normal distribution, you should use another
PASS procedure entitled Equivalence Tests for the Ratio of Two Means (Log-Normal Data) to obtain more accurate
results.

Equivalence Testing Using Ratios
PASS follows the two one-sided tests approach described by Schuirmann (1987) and Phillips (1990). It will be
convenient to adopt the following specialized notation for the discussion of these tests.
Parameter
𝜇𝜇𝑇𝑇

PASS Input/Output Interpretation
Not entered directly
Treatment mean. This is the treatment mean.

𝑅𝑅𝐿𝐿 , 𝑅𝑅𝑈𝑈

𝜇𝜇𝑅𝑅

Not entered directly

Reference mean. This is the mean of a reference population.

RL, RU

Equivalence Limits. These limits define an interval of the ratio of the
means in which their difference is so small that it may be ignored.

𝜙𝜙

R1

Actual ratio. This is the value of 𝜙𝜙 = 𝜇𝜇𝑇𝑇 /𝜇𝜇𝑅𝑅 at which the power is
calculated.

Note that the actual values of 𝜇𝜇𝑇𝑇 and 𝜇𝜇𝑅𝑅 are not needed. Only the ratio of these values is needed for power and
sample size calculations.
With 𝑅𝑅𝐿𝐿 < 1 and 𝑅𝑅𝑈𝑈 > 1, the null hypothesis of non-equivalence is
The alternative hypothesis of equivalence is

𝐻𝐻0 : 𝜙𝜙 ≤ 𝑅𝑅𝐿𝐿 or 𝜙𝜙 ≥ 𝑅𝑅𝑈𝑈 .
𝐻𝐻1 : 𝑅𝑅𝐿𝐿 < 𝜙𝜙 < 𝑅𝑅𝑈𝑈 .
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Coefficient of Variation
The coefficient of variation (COV) is the ratio of the standard deviation to the mean of the control group. This
𝜎𝜎
parameter is used to represent the variation in the data. That is, 𝐶𝐶𝐶𝐶𝐶𝐶 = .
𝜇𝜇𝐶𝐶

Power Calculation
An exact method for the calculation of power and sample size for testing equivalence based on the mean ratio
when the data are assumed to be normally distributed (untransformed) was presented by Hauschke et al. (1999).
This computation requires the evaluation of the noncentral bivariate t-distribution. Kieser and Hauschke (1999)
present a close approximation for the case when RL = 1 / RU (the equivalence limits are the inverse of each
other). This approximation is used in PASS. Kieser and Hauschke (1999) show that the approximation is very
close to the exact method.

Model and Test Details
Suppose a comparison is to be made between two groups: a treatment (T) and a control (C). The response of
interest is assumed to follow the normal distribution with (possibly different) means 𝜇𝜇𝑇𝑇 and 𝜇𝜇𝐶𝐶 and common
variance 𝜎𝜎 2 . To carry out the comparison, a random sample of 𝑁𝑁1 = 𝑁𝑁2 subjects is to be obtained from each
group. The parameters of the study will be presented in terms of the mean ratio 𝜇𝜇𝑇𝑇 /𝜇𝜇𝐶𝐶 .
The equivalence hypotheses are
𝜇𝜇

where 𝑅𝑅1 = 𝜇𝜇𝑇𝑇 .
𝐶𝐶

𝐻𝐻0 : 𝑅𝑅1 ≤ 𝑅𝑅𝑅𝑅 or 𝑅𝑅1 ≥ 𝑅𝑅𝑅𝑅 versus 𝐻𝐻1 : 𝑅𝑅𝑅𝑅 ≤ 𝑅𝑅1 ≤ 𝑅𝑅𝑅𝑅

The null hypothesis 𝐻𝐻0 is rejected in favor of the alternative if a two-sided 100(1 − 2𝛼𝛼)% Fieller confidence
interval is included completely between RL and RU.

Power Approximation
As mentioned above, PASS uses the approximate formulas given by Kieser and Hauschke (1999). These formulas
are stated in terms of the group sample size N1, but they can be rearranged to give formulas for power as well.
If 𝑅𝑅1 = 1, use
If 𝑅𝑅𝑅𝑅 < 𝑅𝑅1 < 1, use
If 1 < 𝑅𝑅1 < 𝑅𝑅𝑅𝑅, use

𝑁𝑁1 ≥ (1

+ 𝑅𝑅𝐿𝐿2 )�𝑡𝑡𝛼𝛼,2𝑁𝑁1−2

𝐶𝐶𝐶𝐶𝐶𝐶 2
+ 𝑡𝑡𝛽𝛽,2𝑁𝑁−2 � �
�
1 − 𝑅𝑅𝑅𝑅
2

𝐶𝐶𝐶𝐶𝐶𝐶 2
2
�
𝑁𝑁1 ≥ (1 + 𝑅𝑅𝐿𝐿2 )�𝑡𝑡𝛼𝛼,2𝑁𝑁1−2 + 𝑡𝑡𝛽𝛽,2𝑁𝑁−2 � �
𝑅𝑅1 − 𝑅𝑅𝑅𝑅

𝐶𝐶𝐶𝐶𝐶𝐶 2
�
𝑅𝑅1 − 𝑅𝑅𝑅𝑅
Note that here, 𝑡𝑡𝛼𝛼,2𝑁𝑁1−2 denotes the 100(1 − 𝛼𝛼)% percentile of the central t distribution with 2N – 2 degrees of
freedom. Also, 𝛽𝛽 is the probability of a type II error.
2

𝑁𝑁1 ≥ (1 + 𝑅𝑅𝑈𝑈 2 )�𝑡𝑡𝛼𝛼,2𝑁𝑁1−2 + 𝑡𝑡𝛽𝛽,2𝑁𝑁−2 � �
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
nonequivalent means when in fact the means are equivalent.
Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90
(beta = 0.10) is commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of nonequivalent means when in fact the means are nonequivalent.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
You can enter a range of values such as 0.05, 0.10, 0.15 or 0.05 to 0.15 by 0.01.

Sample Size
Sample Size Per Group
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be integers ≥ 2.
You can enter a single value or a series of values.
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Effect Size
Equivalence Limit Input Type
Specify whether to specify the upper limit or the lower limit. The other limit will be calculated as the inverse of
the entered limit.
Most experts recommend that the two limits be the inverses of each other so that the limits are invariant to the
order of the means in the ratio: μ1 / μ2 or μ2 / μ1.
Possible choices are
•

Enter Upper Equivalence Limit RU
You enter the upper equivalence limit RU. PASS will calculate the corresponding lower limit, RL, using the
formula RL = 1 / RU.

•

Enter Equivalence Lower Limit RL
You enter the lower equivalence limit RL. PASS will calculate the corresponding upper limit, RU, using the
formula RU = 1 / RL.

RU (Upper Equivalence Limit)
Enter the upper equivalence limit for the ratio of the two means. The other limit, RL, is calculated using
RL = 1 / RU.
When the mean ratio is between this value and RL, the two means are said to be “equivalent”.
You can enter a single value or a list of values.
This value must be > 1. A popular choice is 1.25.
RL (Lower Equivalence Limit)
Enter the lower equivalence limit for the ratio of the two means. The other limit, RU, is calculated using RU = 1 /
RL.
When the mean ratio is between this value and RU, the two means are said to be “equivalent”.
You can enter a single value or a list of values.
This value must be < 1. A popular choice is 0.80.
R1 (Actual Ratio)
This is the value of the ratio of the two means at which the power is to be calculated.
Often, the ratio will be set to one. However, some authors recommend using a ratio slightly different than one,
such as 0.95 (when higher values are "good") or 1.05 (when higher values are "bad"), since this will require a
larger sample size.
COV (Coefficient of Variation)
The coefficient of variation is the ratio of the standard deviation and the mean of the reference (control) group. It
is used to specify the variability (standard deviation) of both groups since these are assumed to be equal.
Note that this COV is defined on the original (not logarithmic) scale. This value must be determined from past
experience or from a pilot study.
You can enter a single value or a list of values.
The permissible range is COV > 0.
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Example 1 – Finding Power
A company has developed a generic drug for treating rheumatism and wants to show that it is equivalent to the
standard drug. A parallel-group design will be used to test the equivalence of the two drugs.
Following standard procedure, researchers set the lower limit of equivalence at 0.80 and the upper limit to 1.25.
Past experience leads the researchers to set the COV to 1.50. The significance level is 0.05. The power will be
computed assuming that the true ratio is 0.9, 0.95, 1.0, 1.05, or 1.1. Sample sizes between 500 and 2500 will be
investigated.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
Sample Size Per Group .......................... 500 1000 1500 2000 2500
Equivalence Limit Input Type ................. Enter Upper Equivalence Limit RU (RL = 1 / RU)
RU (Upper Equivalence Limit) ................ 1.25
R1 (Actual Ratio) .................................... 0.9 0.95 1 1.05 1.1
COV (Coefficient of Variation) ................ 1.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results
R = Treatment Mean / Reference Mean
Hypotheses: H0: R ≤ RL or R ≥ RU vs. H1: RL < R < RU

Power
0.31538
0.50054
0.64480
0.75275
0.83096
0.54030
0.79511
0.91607
0.96761

N1
500
1000
1500
2000
2500
500
1000
1500
2000

N2
500
1000
1500
2000
2500
500
1000
1500
2000

N
1000
2000
3000
4000
5000
1000
2000
3000
4000

Lower
Equiv
Limit
RL
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800

Upper
Equiv
Limit
RU
1.250
1.250
1.250
1.250
1.250
1.250
1.250
1.250
1.250

R1
0.900
0.900
0.900
0.900
0.900
0.950
0.950
0.950
0.950

COV
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500
1.500

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

(Report continues)
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
RL, RU are the lower and upper equivalence limits, respectively, and are the maximum allowable ratios that still
result in equivalence.
R1 is the actual ratio of the means at which power is calculated.
COV is the coefficient of variation on the original scale.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
An equivalence test of the ratio of two group means using two, one-sided tests on untransformed data from a
parallel-group design with sample sizes of 250000 in the reference group and 500 in the treatment group
achieves 32% power at a 5.0% significance level when the true ratio of the means is 0.900, the coefficient of
variation on the original, unlogged scale is 1.500, and the equivalence limits of the mean ratio are 0.800 and
1.250. This test assumes that the original data in each group follows a normal distribution with (possibly) differing
means and common variance.

This report shows the power for the indicated scenarios.

Plot Section

These plots show the power versus the sample size for values of R1.
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Example 2 – Validation using Kieser and Hauschke (1999)
Kieser and Hauschke (1999) page 648 present a table of sample sizes for various scenarios. We will use one
example to validate this procedure. Let the actual ratio be 1.0, the coefficient of variation be 0.35, the equivalence
limits be 0.80 and 1.25, the power be 80%, and the significance level is 0.05. The calculated group sample size is
44.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.8
Alpha ....................................................... 0.05
Equivalence Limit Input Type ................. Enter Upper Equivalence Limit RU (RL = 1 / RU)
RU (Upper Equivalence Limit) ................ 1.25
R1 (Actual Ratio) .................................... 1
COV (Coefficient of Variation) ................ 0.35

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
R = Treatment Mean / Reference Mean
Hypotheses: H0: R ≤ RL or R ≥ RU vs. H1: RL < R < RU

Target
Power
0.80

Actual
Power
0.80349

N1
44

N2
44

N
88

Lower
Equiv
Limit
RL
0.800

Upper
Equiv
Limit
RU
1.250

R1
1.000

COV
0.350

Alpha
0.050

PASS also calculates the per group sample size to be 44, which validates the procedure.
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